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1. Introduction

This document shows step-by-step how easy it is to install the Eclipse IDE in firmware
development with IOsonata.

1.1 Required components

The following are needed for a full development environment for I0sonata and Nordic SDK:
* Eclipse CDT (for C/C++ Development) with GNU MCU plugins
*  ARM GCC compiler
*  OpenOCD for debugging
* IDAPnRFProg command line utility for flashing
* The SDK and all the external libraries

2. Installation

2.1 Installing ARM GCC compiler

Download the ARM GCC compiler package for your OS

GNU Toolchain | GNU Arm Embedded Toolchain Downloads — Arm Developer

You can either select an installer or a tar/zip package. Once installation is completed, note where you
have installed it. You’ll need this to set the full path to the compiler later in Eclipse settings.

The current installer version is GNU Arm Embedded Toolchain: 10-2020-g4-major December 11, 2020

2.2 Installing Build Tools for Windows

Follow these instruction to install the xPack Windows Build Tools binaries (not required on MacOS
and GNU/Linux, use the system tools)

How to install the xPack Windows Build Tools binaries | The xPack Project

2.3 Installing OpenOCD for Source Debugging
In order to do source level debugging in Eclipse, OpenOCD is required. Installing OpenOCD differs
depending on which OS your PC is running.

2.3.1 For OSX use

Use this command in the CLI: brew install openocd --HEAD

2.3.2 For Windows and Linux use

Follow these instructions on GNU MCU

How to install the xPack OpenOCD binaries | The xPack Project

Again, remember the path location where OpenOCD was installed. This path will be set in Eclipse
settings later

2.4 Installing I0sonata and its dependencies
IOsonata is an open source, multi-architecture, highly optimized, hardware abstraction library.
Compiling the I0sonata target libraries requires external SDK & libraries.

Follow the instructions below to download and install with appropriate locations and naming:

nRF5_SDK: Nordic nRF5x Bluetooth Low Energy. Select the latest nRF5_SDK. Unzip it and rename the
folder to nRF5_SDK
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https://www.nordicsemi.com/Software-and-tools/Software/nRF5-SDK/Download#infotabs
https://xpack.github.io/openocd/install/
https://xpack.github.io/openocd/install/
https://xpack.github.io/windows-build-tools/install/
https://developer.arm.com/tools-and-software/open-source-software/developer-tools/gnu-toolchain/gnu-rm/downloads
https://developer.arm.com/tools-and-software/open-source-software/developer-tools/gnu-toolchain/gnu-rm/downloads

nrf5_SDK_Mesh: Nordic nRF5 SDK for Bluetooth Mesh. Unzip it & rename the folder to
nrf5_SDK_Mesh.

ICM-20948 Motion_Driver: First, create a user. In the "Development Kits" block, download "DK-
20948 SmartMotion eMD 1.1.0". Unzip the downloaded file and navigate to EMD-Core/sources. Copy
the folder Invn to external/Invn as indicated in the folder tree below.

BSEC: Bosch Sensortec Environmental Cluster (BSEC) Software for #8BME680 environmental sensor.
BSEC is needed for calculating Air Quality Index.

Go to https://www.bosch-sensortec.com/bst/products/all_products/bsec. At the end of the page
select the checkbox to accept license terms and download. Unzip the downloaded file. Rename the
extracted folder BSEC, then copy the whole folder to external as indicated in the folder tree below.

LWIP: A Lightweight TCP/IP stack. This library is required for loT network connectivity over Ethernet,
Wifi, LTE etc. Download it via this link. Rename the extracted folder as lwip and copy it to external.

The way the IOsonata folder is structured is simple. The deeper you go inside, the more specific it is
to the architecture or platform. The parent folder contains everything commonly available to the
child folder. This means source files from the child folder can access any source in the upper parent
folder, but not the other way around. This keeps the abstraction separated from implementation and
makes it easier to keep track of things.

/your_root - Development root directory

|-- external - Contains downloaded SDKs from silicon vendors

| | -- nRF5_SDK - Latest Nordic SDK (https://developer.nordicsemi.com)

| | | | -- components

| | | |-- examples

[ ...

| | -- nRF5_SDK_12 - Last version of Nordick SDK12 for nRF51 series

| | | |-- components

| | | |-- examples

| |...

| |-- nrf5_SDK_Mesh - Latest Nordic SDK for Mesh

[ | | [|-- Mesh

| | | |-- Models

| |...

| |-- BSEC - Bosch Sensortec Environmental Cluster (BSEC) Software (https://www.bosch-
sensortec.com/bst/products/all_products/bsec) for #BME680

| |-- Invn - Invensense SmartMotion Driver (download

https://www.invensense.com/developers)

| | |-- Devices

[ N P

| |-- 1wip - Lightweight TCP/IP stack (download
https://download.savannah.nongnu.org/releases/lwip/)

| |-- Others as require

| I...

[

| -- IOsonata - Put the IOsonata here
| |-- include - Generic include common to all platforms
| | |-- bluetooth - Generic definition for Bluetooth

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved 6


https://download.savannah.nongnu.org/releases/lwip/
https://savannah.nongnu.org/projects/lwip/
https://www.bosch-sensortec.com/bst/products/all_products/bsec
https://www.bosch-sensortec.com/bst/products/all_products/bsec
https://invensense.tdk.com/developers/software-downloads/
https://invensense.tdk.com/developers/software-downloads/
https://www.nordicsemi.com/Software-and-Tools/Software/nRF5-SDK-for-Mesh/Download#infotabs

|-- converte
|-- coredev
|-- miscdev
|-- sensors

|-- usb

| -- bluetoot
|-- converte
|-- coredev
|-- miscdev
|-- sensors

|-- usb

|-- include
|-- src

| -- DbgConfi
|-- 1dscript

https://www.i-syst.com

rs -

Generic
Generic
Generic
Generic

Generic

definition

definition

definition

definition

definition

- Generic implementation

h =
rs -

- ARM

g o

-- nRF52832

Generic
Generic
Generic
Generic
Generic

Generic

source

source

source

source

source

source

for
for
for
for
for

for

series based MCU

for ADV, DAC, etc...

MCU builtin devices such as i2c, uart, spi, timer, etc...
for other non categorized devices

for al sort of sensors (environmental, motion, etc...)
for USB

source common to all platforms

Bluetooth

ADV, DAC, etc...

MCU builtin devices such as i2c, uart, spi, timer, etc...
other non categorized devices

al sort of sensors (environmental, motion, etc...)

UsB

Common include for all ARM platform

Common source for all ARM platform

Debugger configuration files.

Linker script files

Nordic Semiconductor based MCU
- nRF52 serie MCU

- Common include for this target series

- Common source for this target series

|-- 1ib

|-- Eclipse

|-- IAR

exemples

- Target MCU

- IOsonata library for this target

- Eclipse project for this lib

- IAR project for this lib

|-- CrossWorks- CrossWorks project for this 1lib

- Example projects for this target

- Blink example

|-- src

|-- Eclipse

|-- 1AR
| -- CrossWorks- CrossWorks project for this example

- Source code for this exaple

- Eclipse project for this example

- IAR project for this example

|-- Many other examples same

nRF52840

I

I

I

I

I
|__
| |-- Blink
I

I

I

I

I

I

I

|-- Eclipse
|-- IAR
| -- CrossWorks- CrossWorks project for this lib

- Target MCU

- IOsonata library for this target

- Eclipse project for this 1lib

- IAR project for this lib
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-- exemples - Example projects for this target

|-- Blink - Blink example

| |-- src - Source code for this exaple
|-- Eclipse - Eclipse project for this example
|-- IAR - IAR project for this example

-- Many other examples same

I
I
| |-- CrossWorks- CrossWorks project for this example
I
I

2.5 Installing Eclipse

Start by downloading Eclipse IDE for C/C++ Developers here: https://www.eclipse.org/downloads/.
1. Start the Eclipse installer.
2. Select "Eclipse IDE for C/C++ Developers".

eclipseinstaller s com:

type filter text

BN =
Q

The essential tools for any Java developer, including a Java IDE, a Git client,
XML Editor, Maven and Gradle integration

@ Eclipse IDE for Java Developers

ﬁ Eclipse IDE for Enterprise Java and Web Developer

Tools for developers working with Java and Web applications, including a
Java IDE, tools for JavaScript, TypeScript, JavaServer Pages and Faces,...

@ Eclipse IDE for Embedded C/C++ Developers

An |DE for Embedded C/C+ developers. Itincludes managed cross build
plug-ins (Arm and RISC-V} and debug plug-ins (SEGGER J-Link,...

% Eclipse IDE for PHP Developers

The essential tools for any PHP developer, including PHP language
support, Git client, Mylyn and editors for JavaScript, TypeScript, HTML,...

3. Select the install directory

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved 8


https://www.eclipse.org/downloads/

DONATE

eclipseinstaller s, come =
Eclipse IDE for C/C++ Developers details
@ An IDE for C/C++ developers.

Java 11+ VM i.edipse.org/justj/jres/15/updates/releases15.02 v Be

Installation Folder \Developmentiecli \ 03 [ —

" create start menu entry

" create desktop shortcut

& INSTALL

€ BACK

4. Click "Install". Installation will start with a pop-up asking you to agree to the license. Accept and

continue.

5. Now that is installed, start Eclipse and select where you want your workspace location.

= Eclipse IDE Launcher

Select a directory as workspace
Eclipse IDE uses the workspace directory to store its pref es and devel t artifacts,

[]Use this as the default and do not ask again

Launch | | Cancel

6. Be patient, Eclipse is a bit slow to start. A welcome screen will show up. On the top right, select
Open Workbench perspective. Select from the menu ‘Help/Eclipse Marketplace...”. A pop-up will
appear. Type ‘arm’ in the search box and install the ‘GNU MCU Eclipse ...". Again, say "yes" to all the

licenses.

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved



S Eclipse Marketplace O X

Eclipse Marketplace

Select solutions to install. Press Install Mow to proceed with installation.
Press the "more info" link to learn more about a solution,

Sealchl Recen1| Popular| Favcrlil5| Installed| ' Giving loTan Edge|

Find: All Markets + | | All Categories v [Ge]
Ll

Eclipse Embedded C/C++ 6.1.2

The Eclipse Embedded CDT (C/C++ Development Toels, formerly GNU
MCU/ARM Eclipse) is an open source project that includes a family of
Eclipse plug-ins and tools.. more info

by Liviu lonescu, EPL
GNU Arm Cortex-M RISC-V J-Link

E Installs: 121K (3,925 last month)

EmbSysRegView 0.2.6

EMBedded 5Y5terns REGister VIEW is an Eclipse Plugin which is designed
for menitoring and modifying memery values of embedded devices.
Therefore it offers a... more info

by Missing name Mising name, EPL

EmbSysRegView memory memaory view memory values memory
moenitoring

Inctalls: 6.80K (21 last manth)

impulse Embedded Extension 2.1.4

This solution listing is an extension for impulse. The main impulse
solution listing can be found here (with the option to install multiple
g extensions), impulse.. more info

by toermn GmbH, Free for non-commerical use
impulse Waveform Plot signal analysis v

Marketplaces

= e

@ <Back  InstallNow> Finsh || Cancel

7. Next step is to set the path to the toolchains. Open Eclipse preferences. For Linux & Windows, look
in Help menu list. For OSX, prefs are in the usual place. A pop-up will appear. Find ‘MCU’ from the list
on the left side and open it. Inside, set the path for both GCC and OpenOCD in the global section.

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved 10



S Preferences O x

[ type filter text Global Arm Toolchains Paths CREVRS |

» C/C++ A
Changelog
Docker
Help
Install/Update Toolchain name: |I(Pack GMU Arm Embedded GCC
Library Hover
w MCU
Global Arm Teolchains Paths
Global Build Tools Path
Global OpenQCD Path
Global pyQOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path
> Mylyn
» Oomph
» Remote Development v

Configure the locations where various GNU Arm toolchains are installed. The values are stored within Eclipse. Unless redefined more
specifically, they are used for all projects in all workspaces.

Default toolchain: | xPack GNU Arm Embedded GCC v

VoW W W

Toaolchain folder: | D:vi_syst\Development\GMNU Arm Embedded Toolchaln\102M0-q4-maJor| | Browse... | | xPack... |

| Restore Ddauhs| | Apply |

@i @® [Applyand Close] | cancet |

S Preferences O *

[ type filter text Global OpenOCD Path CR AR

5 CfC++ ~
Changelog

Docker

Help After installing OpenOCD updates, restart Eclipse for the defaults to be re-evaluated and use the Restore Defaults button to configure
Install/Update the new location.

Configure the location where xPack OpenOCD is installed. The values are stored within Eclipse. Unless redefined more specifically,
they are used for all projects in all workspaces.

Library Hover Executable: ‘ openocd.exe |
MCu
Global Arm Teelchains Paths
Global Build Tools Path
Global OpenQCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace GEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path
> Mylyn
» Oomph
» Remote Development v

€ v v v v

Folder: ‘C:;’Users«’TAIHM:’AppDatafRoaming;’xPacksfopenocde.‘l‘I‘Df'\;’bin ‘ | Browse... | ‘ xPack... |

‘ Restore Defaults ‘ ‘ Apply |

@Ouea® [Applyand Close] | cancel |

That is all that’s needed for Eclipse and toolchain installations. This Eclipse installation is not limited
to Nordic based development. It is a generic installation that allows you to work with any ARM
Cortex MCU from any vendor. It works for RISC-V as well. You will need to install toolchains for RISC-
V if you want to work with that in Eclipse.

Important notes for OSX users

Since the Catalina update, there is a new security measure that blocks the execution of command
line tools such as the GCC compiler and OpenOCD and other downloaded executables. First thing,

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved
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open System Preferences/Security & Privacy/Privacy. Select ‘Developer Tools’. Then add Eclipse to
the list.

Now that Eclipse and all the toolchains are fully installed, lets start compiling. Select menu ‘File/Open
Projects from File System...".

S eclipse-workspace - Eclipse IDE - O x
File Edit Source Refactor Mavigate Search Project Run  Window Help
New Alt+Shift+N > h Configurations V| on: ‘ - ~ |' I I Hh%]' B~ Q " 2 ‘%
Open File... ) L . .
L mPeedstomfessen., LT SO 0T 3 =
Recent Files H S B Bo® * = O {@Hdp 2 @) Welcome = 08
oo
Close Editor Cirl+W e B | c=t
Close All Editors Ctal+ Shift+W Shete & ho acesiior | & Contents ¥ search
P } EKE Related Topics El] Bookmarks
5] Save Ctrl+5 B Index
|zl SaveAs...
@ SaveAl Cirl+ Shift+$ > Search expression:
Revert | | hd |
Move... » Scope Default
[#] Rename.. F2
& Refresh F3
Convert Line Delimiters To ¥
& Print... Ctrl+P
¥ Import..
i Export.
Properties Alt+Enter
Switch Workspace >
Restart
Exit
[2] Problems &2 £ Tasks [ Consele [ Properties T & = O
Diterns
Description . Resource Path Locatior
< >

A pop-up will open. Click on the "Directory" button, navigate to, and select the ‘nRF52832’ folder in
the |0sanota/ARM/Nordic/nRF52/ location. Eclipse will search and list all projects available within

that folder. Deselect the first checkbox ‘nRF52832’ and keep all the others. For the BLYST840, use the
‘nRF52840’ instead.

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved 12


https://www.crowdsupply.com/i-syst/blyst840

= Import Projects from File System or Archive

Import Projects from File System or Archive

This wizard analyzes the content of your folder or archive file te find projects and import them in the IDE.

] nRF32840\exemples\AdcDema'\Eclipse

[~] nRF32840\exemples\AnalogCompDemaEclipse
[] nRF52B40\exemples\BleAdvertiser\Eclipse

7] nRE52840 les\Blinky\Ecli

Eclipse project
Eclipse project
Eclipse project
Eclinse project

Import source: | Di\i_syst'Development\|Dsonata\ ARM\Nordic\nRF52\nRF32840 v| I Directory... | | Archive |

| type filter text | | Select All |

Folder Import as i | Deselect All |
] nRF52840

39 of 39 selected
v | [ Hide already open projects

[] Close newly imported projects upon completion

Use installed project configurators to:
[#] Search for nested projects

[~] Detect and configure project natures
Working sets

[[] Add project to working sets

Show ather specialized import wizards

)

Click ‘Finish’. Eclipse will load all projects into the project explorer on the left pane. Select & right-
click on the ‘l10sonata_nRF52832’ project. Then select ‘Build Configuration/Build All’ to build all
variants of the I0sonata library for the nRF52832.

https://www.i-syst.com
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File Edit Source

[&]le][s]

s eclipse-workspace - Eclipse IDE

Refactor  Mavigate

Search  Project Run  Window Help

W | | Mo Launch Cenfigurations

- [m] >

[H-HE B~/ -8

(Biw| S
5 Project Exp!

" g dfu_uart
> @ Inclus
> Bp src

> g dfu_uart

> ﬁ Eeproml

v g I0sonat:
b3 @ Inclus
> [y inclu
> gy sre

~ [ nRF5284
> fgr exem
> [= ldscri
> = lib

X O il

EE

]

(V]
%

L4

E IOsonaIa_nI

Mew

Go Into

Open in New Window
Show In

Show in Local Terminal

Copy

Paste

Delete
Source
Move...
Rename...
Import...
Export...
Build Project
Clean Project
Refresh
Close Project
Close Unrelated Projects

Build Targets

Index

Profiling Tools
Run As
Debug As
Profile As

Restore from Local History...

Run C/C++ Code Analysis
Team

Compare With

Alt+Shift+W

Ctrl+C
Ctrl+V
Delete

F2

F5

3

2

2

3

i Help 52 (%) Welcome

Q x|[E
= 8

m[E] < o> §

[E Contents Q) Search
BE Related Topics Em Bookmarks

Bl Index

b Search expression:

] [ee]

» Scope Default

v | on: | - v
oS S RE T OO
= 8 = B8
O
There is no active editor
that provides an outline,
Set Active 3
Manage... T § = 0O
Clean All Path Locatior
Build Selected...

You may encounter the following failure

Eﬂ Problems J£| Tasks B Console 2 [C] Properties
COT Build Console [IOsonata_nRF32832]

X Lo EE=EE rB--= 0

22:19:59 **** Incremental Build of configuration Debug NoReset for project IOscnata_nRF52832 *%+*

make -j4 all

Cannot run program "make”: Launching failed

Error: Program "make™ not found in PATH

PATH=[D:\i_syst\Development\GNU Arm Embedded Toolchain\1® 2828-g4-major\bin;C:/Users/TAIHM/.p2/pool/plugins/org.eclipse.justj.openji

22:19:59 Build Failed. 1 errors, @ warnings. (tock 123ms)

If you are using GNU MCU Eclipse on Windows, make sure Windows Build Tools are installed, then
check the installation path and fill the "Global Build Tools Path" inside Eclipse
Window/Preferences... :

https://www.i-syst.com
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https://gnu-mcu-eclipse.github.io/windows-build-tools/install/

& Preferences - [m] X

[type filter text Global Build Tools Path Gro- g

> General ~
5 CfCes
Changelog Build tools folder: | C:\Users\ ML AppDatz\ Roaming\u Packs\windaws-build-tools\xpack-windows-build-tools-421-2bin__ | | Browse.. | | aPack. |

The locations where various Eclipse Embedded CDT build tools are installed, Unless defined more specifically, they are used for all projects in all workspaces,

» Docker

» Help

> Install/Update

> Library Hover

v MCU
Global Arm Toolchains Paths
Global Build Tools Path
Global OpenOCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toclchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Waorkspace QEMU Path
Workspace RISC-V Teolchains Paths
Workspace SEGGER J-Link Path

: g::::h v ‘Rslme Dclaulls| ‘ Apply |
@ s @ [Applyand Close] | Cancel |

It will take a while to compile all the libraries. There is a lot of source code. Look at the bottom pane
in the ‘Console’ tab for the compilation results.

*) Problems ] Tasks | B Console 37 [ Properties *
5 & P
COT Build Console [|Osonata_nRF52840]

Include Browser

Building file: D:/i syst/Development/IOsonata/src/uart_retarget.c
Invoking: GNU ARM Cross C Compiler

arm-none-eabi-gcc -mcpu=cortex-md -mthumb -mfloat-abi=hard -mfpu=fpv4-sp-di6 -0Os -fmessage-length=p -fsigned-char -ffunction-sections -fdata-sections -g -D__PROGRAM_START -DNDEBUG -DCONFIG_NFC
Finished building: D:/i_syst/Development/IOsonata/src/uart_retarget.c

Building file: D:/i_syst/Development/IOsonata/src/utf8.c

Invoking: GNU ARM Cross C Compiler

arm-none-eabi-gcc -mcpu=cortex-m4 -mthumb -mfloat-abi=hard -mfpu=fpv4-sp-di6 -Os -fmessage-length=p -fsigned-char -ffunction-sections -fdata-sections -g -D_ PROGRAM _START -DNDEBUG -DCONFIG_NFC
Finished building: D:/i_syst/Development/I0sonata/sre/utfs.c

Building file: D:/i_syst/Development/I0sonata/src/utf8cvt.cpp

Invoking: GNU ARM Cross C++ Compiler

arm-none-eabi-g++ -mcpu=cortex-md -mthumb -mfloat-abi=hard -mfpu=fpvd-sp-d16 -Os -fmessage-length=@ -fsigned-char -ffunction-sections -fdata-sections -g -D_ PROGRAM_START -DNDEBUG -DCONFIG_NFC
Finished building: D:/i_syst/Development/I0sonata/src/utfBevt.cpp

Building target: 1ibIOsonata nRF52848.a

Invoking: GNU ARM Cross Archiver

arm-none-eabi-ar -r "1ibIOsonata nRF52848.a" ./src/sensors/accel_adx1362.0 ./src/sensors/accel h3lis331dl.o ./src/sensors/accel lis2dhi2.o ./src/sensors/accel sensor.o ./src/sensors/ag bmilse

arm-none-eabi-ar: creating libIOsonata nRF52848.a
Finished building target: libIOsonata_nRF52840.a

20:36:52 Build Finished. & errors, 2 warnings. (took 4m:2s.236ms)

Once the library compilations are complete, you can build any example project listed. To start, let’s
build the Blinky example. Select the Blinky project to highlight it. Find the hammer in the middle of
the toolbar and click on it to build the highlighted project.

https://www.i-syst.com © Copyright 2019 I-SYST inc. All Rights Reserved
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& cclipse-workspace - Blinky/src/board.h - Eclipse IDE
File Edit Source Refactor Navigate Search Project Run Window Help

[&][o][m][-

v | ‘ No Launch Configurations

= .

frfl-edo-o-m

B Project Explorer 33 &Y 8§ = O [gblinky.c
71

O-HR ®-4-@i0i%iu|dig-a8-F-&-

> 5 AdcDemo (in Eclipse)
> |25 AnalogCompDemo (in Eclipse)
5 15 BleAdvertiser (in Eclipse)
~ [ Blinky (in Eclipse)

> 4% Binaries

> @il Includes

» (= Debug

> [ Release

> (= Release_mbr

v iy src

> [ blinky.c
> [ boardh

5 S BluelOThingy (in Eclipse)
> S cli (in Eclipse)
5[5 dfu_ble (in Eclipse)
> &5 dfu_usb (in Eclipse]
5 5 dfu_usb_open (in Eclipse)
> 5 EinkDiisplayDemo (in Eclipse)
> |25 ESBpx (in Eclipse)
> [£5 ESBptx (in Eclipse)
5 (25 FlashMemoryDemo (in Eclipse)
> &% 12CMasterSlave (in Eclipse)
> 5 Osonata_nRF52840 (in Eclipse)
5 |5 LedDemo (in Eclipse)
> &5 MeshLgtSwClient (in Eclipse)
5 &5 MeshLgtSwServer (in Eclipse)
> S MotionSensorDemo (in Eclipse)
5 15 PulseTrain (in Eclipse)
> |25 PwmbDemo (in Eclipse)
> S radio_test (in Eclipse)
> &5 SPIMasterSlave (in Eclipse)
5 (25 TimerDemo (in Eclipse)
5 5 TPHDemo (in Eclipse)
> &= TPHSensorTag (in Eclipse)
5 15 UartBleBridge (in Eclipse)
5 |25 UartBleCentralDemo (in Eclipse)
5 15 UartBleDemo (in Eclipse)
> 5 UartBleFreeRTOS (in Eclipse)
5 15 UartnRFLogTest (in Eclipse)
>[5 UartPrbsRaTest (in Eclipse)
5 15 UartPrbsTuTest (in Eclipsz)
5 [£% UartRetargetDemo (in Eclipse)
5 25 UartSdkPrbsTest (in Eclipsz)
5 15 UartSlipPrbsRucTest (in Eclipse)
5 |25 UartSlipPrbsTTest (in Eclipse)
> 5 usb_cde_acm (in Eclipse)

125 Blinky

[ boardh 3% =0
#detine LED3_PIN BLUEIO_LED3_PIN "

72 #define LED3_PINOP BLUEIO_LED3_PINOP

73

74 #define LED4_PORT BLUEIO_LED4_PORT

75 #define LED4 PIN BLUEIO_LED4 PIN

76 #define LED4_PINOP BLUEIO_LED4_PINOP

77

78= #define BUTTON_PINS_MAP i\

79 {BUT1_PORT, BUT1_PIN, BUT1_PINOP, IOPINDIR_INPUT, IOPINRES_PULLDOWN, IOPINTYPE_NORMAL}, \

80 {BUT2_PORT, BUT2 PIN, BUT2 PINOP, IOPINDIR INPUT, IOPINRES PULLDOWN, IOPINTYPE NORMAL}, \

81 }

82

83= #define LED_PINS_MAP N

84 {LEDI_PORT, LED1_PIN, LEDI_PINOP, IOPINDIR_OUTPUT, TOPINRES_NONE, IOPINTYPE_NORMAL}, \

a5 {LED2_PORT, LED2 PIN, LED2Z PINOP, IOPINDIR OUTPUT, IOPINRES NOME, IOPINTYPE NORMAL}, \

86 {LED3_PORT, LED3_PIN, LED3_PINOP, IOPINDIR OUTPUT, TOPINRES NOME, IOPINTYPE NORMAL}, \

87 {LED4_PORT, LED4_PIN, LED4 PINOP, IOPINDIR OUTPUT, TOPINRES NOME, IOPINTYPE NORMAL}, \

88 }

89

2= #define PULSE_TRAIN PINS MAP  { \

91 {8, 2, @}, {8, 3, @}, {8, 4, @}, {8, 5, @}, {8, 6, @}, {8, 7, 8}, \

92 {e, 8, e}, {8, 9, @}, {e, 18, @}, {8, 11, &}, {0, 12, B}, {@, 13, @}, {@, 14, @}, {8, 15, B}, \

93 {8, 16, e}, {8, 17, @}, {8, 18, 8}, {8, 19, 8}, {8, 28, 8}, {8, 21, @}, {8, 22, @}, {8, 23, 8}, \

94 {e, 24, e}, {e, 25, e}, {e, 26, @}, {@, 27, e}, {e, 28, e}, {e, 29, @}, {e, 3@, @}, {@, 31, @}, \

95 {1, e, e}, {1, 1, e}, {1, 2, e}, {1, 3, @}, {1, 4, @}, {1, 5, e}, {1, 6, @}, {1, 7, @}, \

96 {1, 8, 8}, {1, 9, @}, {1, 18, @}, {1, 11, e}, {1, 12, @}, {1, 13, @}, {1, 14, e}, {1, 15, 8}, \

97 }

98

99 #endif // __BOARD H__

100 v

< >
i8Il Problems ) Tasks B Console 52 [ Properties ®|
CDT Build Console [Blinky]
arm-none-eani-gec -MCPU=COrteX-ma -MENUMD ~MT [0aT-aDI=nard -mTpU=TpVa-5p-als -Us Tengen=n -Tsigned-cnar -TTUNCTION-SeCTIONs -TOata-Sectic
: o

Finished building:

:/i_syst/Development/I0sonata/ /blinky.c

Building target: Blinky.elf
Invoking: Cross ARM C Linker

arm-nene-eabi-gcc -mcpu=cortex-mé -mthumb -mfloat-abishard -mfpu=fpvé-sp-d1s -Os -fmessage-length=2 -fsigned-char -ffunction-sections -fdata-sectic

Finished building target: Blinky.elf

Invoking: Cross ARM GNU Create Flash Image
arm-none-eabi-objcopy -0 ihex "Blinky.elf"
Finished building: Blinky.hex

"Blinky.hex"

Invoking: Cross ARM GNU Print Size

arm-n bi-size --format=berkeley "Blinky.elf"
text data bss dec hex filename
2668 768 136 3572 df4 Blinky.elf

Finished build Blinky.siz

26:44:25 Build Finished. @ errors, @ warnings. (took 834ms)

<
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